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Introduction 
Welcome to Designing with Purpose: A Beginner's Guide to PowerPoint Presentations. 
Whether you are new to computers or looking to expand your skills with Microsoft 
PowerPoint, this book is designed to help you navigate and master one of the most 
powerful tools for creating impactful presentations. 

Starting with the basics, we will guide you through the essential features that form the 
foundation of PowerPoint. You will learn how to view and save presentations, 
understand the various PowerPoint views such as Normal and Slide Sorter, and get 
comfortable with using helpful tools like the Help feature to troubleshoot along the way. 
As you progress, you will gain insights into how to select a topic, define your audience, 
and create an engaging title to make your presentation stand out. 

You will then move on to more advanced techniques, like creating slides, modifying 
text, and using tools in the Font Group and Paragraph Group to format your content 
effectively. We will also cover how to arrange and align objects, add images, and use 
themes to enhance the visual appeal of your slides. Additionally, you will learn how to 
use grouping to organize elements on your slides for a clean and professional layout. 

By the end of this book, you will have a solid understanding of how to develop and 
present content that engages your audience, looks visually impressive, and 
communicates your message with clarity. Whether you are preparing a school project, a 
business presentation, or anything in between, this guide will help you create 
presentations that leave a lasting impact. 

So, let’s get started with the basics and work our way up to mastering PowerPoint for 
your next successful presentation!i 
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PowerPoint: Getting Started 
Objectives of Chapter One 

1. View a Presentation 
2. Save a Presentation 
3. Get Help 
4. Exit PowerPoint 

View a Presentation 
PowerPoint has diverse ways of displaying a presentation. These views have their 
own advantages when creating, editing, and viewing a presentation. The view 
selection options are located at the bottom of the window next to the label 
“Display Settings,” and are, from left to right, Normal, Slide Sorter, Reading View, 
and Slide Show (Figure 1.1). 

 
Figure 1.1 PowerPoint presentation views include Normal, Slide Sorter, Reading , and Slide Show 

Normal 
Normal view is the default view for PowerPoint. When a user logs in, this is the 
view that the user will see. The main characteristic of this view is that the working 
slide is identified by a red rectangle on the left part of the window and a bigger 
picture of that same working slide is on the right (Figure 1.2). 
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Figure 1.2 In Normal View, the working slide is on the right and all the slides from the presentation are on the left.  

Slide Sorter 
Slide Sorter view displays all the slides in the file. The slides are the same size. 
This view is convenient because the user can see all the slides in a file at one 
time. These slides provide an overview of the presentation at a glance (Figure 
1.3). 

 
Figure 1.3 PowerPoint Slide Sorter view shows all the slides contained in the file. 
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Reading View 

Reading View provides a similar experience to viewing the slide show. The user 
will see one slide at a time in the PowerPoint window. This view is beneficial 
because the user can see a full or nearly-full view of the slide and still access 
other view tools (Figure 1.4). 

 
Figure 1.4 PowerPoint Reading view shows an amplified view of the working slide.  

Slide Show 

The Slide Show view is beneficial because it allows the user to view the 
presentation on the whole screen, unconstrained by a PowerPoint window. This 
view is ideal for presenting to an audience. In Slide Show, like in Reading view, 
slides can be advanced using the arrow keys or by clicking the slide. (Figure 1.5).  
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Figure 1. 5 Slide Show view shows a full screen view, typically used for presentations. 

Save a Presentation 
One of the most essential tools in PowerPoint is Save. The Save tool is crucial as 
you work to avoid losing your presentation. To save a new file for the first time, 
use Save As to identify your chosen location or folder. Thereafter, use Save to 
preserve updates to that file.

1. Open the File tab (Figure 
1.6) 

2. Click Save As (Figure 1.7 
point 1) 

3. Select Browse (Figure 1.7 
point 2) 

4. Navigate to the desired 
folder and/or subfolder 
(Figure 1.8) 

5. Click the folder (Figure 1.9) 
6. Enter a File Name and click 

the Save button (Figure 
1.10)

 

 
Figure 1.6 File tab is in the top left corner under the 
PowerPoint logo. 
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Figure 1.7 The File tab options include Home, New, Open, Share, Save, Save As, and other options.  
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Figure 1.8 The Browse view allows users to select or create a folder inside of the local computer or outside the computer, 
in the Cloud.  

 
Figure 1.9 Identify the folder to save or create a new folder. 
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Figure 1.10 Use the File Name field to give the file a name and click Save. 

Get Help 
PowerPoint, like other Microsoft Office software, has a Help tool. This tool is useful 
when the user is not sure how to use a tool or when the user knows a tool’s function 
but cannot remember its name or location. 

There are two ways to get help in PowerPoint. The user can use the search bar at the 
top of the Microsoft PowerPoint window (Figure 1.11) to ask a question or enter a 
search term, such as the name of a tool. Users can also click the Help tab to access 
the options “Help,” “Contact Support, “Feedback,” “Show Training,” and “What’s 
New.” 

 
Figure 1.11 The search bar at the top of the window allows users to seek information from Microsoft’s catalog of articles, 
and the Help tab offers other options. 
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Exit PowerPoint 
When you are ready to exit PowerPoint, click the “X” in the upper right corner of the 
window. Remember to save any work before exiting! 

 
Figure 1. 12 The exit button is in the far-right corner on the top of the program window. 
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Effective PowerPoint Presentations  
Objectives of Chapter Two 

1. Identify the Topic, Audience, and Title for an Effective Presentation 
2. Develop the PowerPoint Presentation 

The user's goal in developing a presentation is to be effective. This chapter will discuss 
what makes an effective presentation. For this, we will draw from the 2022 book Strategies 
for Effective Business Communication.ii  

Identify the Topic, Audience, and Title 
Let’s break down the process of selecting a topic, tailoring presentation content to 
engage the audience, and deciding on a title. 

Selecting a Topic 
1. Interest and Relevance: 

o Your own Interest: Select a topic you are enthusiastic about or familiar 
with. That will make the presentation more engaging for you and your 
audience. For example, if you are interested in technology, you might opt 
to present on the latest advancements in artificial intelligence (AI). 

o Relevance to the Audience: Ensure the topic is relevant to your audience. 
A presentation on AI advancements would be highly relevant if your 
audience consisted of tech enthusiasts. Keep your audience in mind 
when you are in the topic selection process. 

2. Purpose and Objectives: 

o Specific Purpose Statement: Write a specific purpose statement that 
outlines what you want to achieve with your presentation. For instance, 
"The purpose of this presentation is to inform my classmates about the 
ethical implications of AI in the workplace." 

o Formula for Specific Purpose Statement: To compose your statement, 
use the formula Specific Communication Word + Audience + Content 

https://louis.pressbooks.pub/businessprofessionalcomm/
https://louis.pressbooks.pub/businessprofessionalcomm/
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 Specific communication words might include: inform, explain, 
demonstrate, describe, define, persuade, convince, prove, argue 

 Your target audience might be classmates, co-workers, or anyone 
you want to inform. Identify them! 

 The content is the material you’ll present. 

 Example Specific Purpose Statement created using the formula: 
"To inform my classmates about the ethical implications of AI in 
the workplace." 

3. Content and Structure: 

o Brainstorming: Use techniques like brainstorming or mapping to list 
concepts under your main topic. For AI, you might list subtopics like 
machine learning, ethical considerations, and practical applications. 

o Refine Your Content: Based on your audience analysis, refine your 
content to ensure it is appropriate and engaging for them. If your 
audience is non-experts, avoid overly technical words. 

Tailoring Presentation Content to Engage the Audience 
1. Understand Your Audience: 

o Analyze Your Audience: Determine who will be listening to your 
presentation. Are they experts, non-experts, or both? Tailor your message 
accordingly. For example, if your audience includes both tech experts and 
laypeople, you might need to provide a balanced mix of technical details 
and accessible explanations. 

o Consider Demographics: Adjust your message based on your audience’s 
level of education, age group, profession, and other relevant 
demographics. 

2. Use Slides Effectively: 

o Design Slides for Your Topic: We will work in-depth on this topic, including 
how to use PowerPoint's Styles and Themes feature to create a consistent 
theme. Slides can significantly affect the mood and flow of your 
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presentation. For instance, images of AI applications can make abstract 
concepts more tangible. 

o Keep Slides Simple: Use slides to complement your content, not replace 
it. Avoid overloading slides with text. Instead, focus on critical points and 
use images, charts, and graphs to illustrate your points. 

3. Incorporate Interactive Elements: 

o Engage Your Audience: Use questions, stories, and anecdotes to keep 
your audience engaged. For example, you might start with a thought-
provoking question about how AI might impact their daily lives. 

o Get Feedback: Practice your presentation on peers and gather feedback. 
This will help you refine your content and delivery based on real-world 
reactions. 

Choosing a Title 
1. Reflect the Content: 

o Specific and Descriptive: Your title should reflect the content of your 
presentation. It’s good practice to decide on the title at the end of your 
work, when you have a clear view of what your content is. For the AI 
example, a title like "The Future of Work: How AI is Transforming 
Industries" is specific and descriptive. 

o Engaging: Choose a title that piques the audience’s interest. Avoid 
generic titles that do not grab attention. 

2. Use Keywords: 

o Relevant Keywords: Include keywords relevant to your topic that your 
audience might be searching for. This helps in making your presentation 
more discoverable and relatable. 

o Example: If you are presenting on AI in healthcare, a title like 
"Revolutionizing Healthcare: The Impact of AI on Medical Diagnostics" 
uses relevant keywords and is engaging.  
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3. Be Concise: 

o Keep it Short: A concise title is easier to remember and conveys your 
message more effectively. Avoid lengthy titles that might confuse or 
overwhelm your audience. 

By following these guidelines, you will be well-equipped to select a topic, tailor your 
presentation content to engage the audience, and define a title that engages and 
reflects your content. 

Develop the PowerPoint Presentation 
Once you have a clear view of the topic and the audience, it is time to start 
developing slides. Developing slides is a process, so the first attempt does not 
have to be perfect, but it will give you a general idea of your target. Let’s start 
developing our first PowerPoint presentation together. 

Open and Name Your File 
The first step in creating a presentation is opening PowerPoint and selecting Blank 
Presentation (Figure 2.1). This will open a new, blank, presentation in Normal view 
(Figure 2.2), with a slide that invites you to add a title and subtitle.   

Hint: type a title that you think describes your content. Remember, this title does not 
have to be your final title; we are just playing with the words to see if they identify the 
content correctly (Figure 2.3). The subtitle space is a good place to add your specific 
purpose statement, which will keep you focused on the content you want to create. 

 
Figure 2. 1 Blank Presentation is the recommended option to start working with PowerPoint. The option is on the left side 
of the window, identified by a white rectangle. 
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Figure 2. 2 A new blank project opens in Normal View, with a template for a title slide and space to add a title and subtitle. 

 

  
Figure 2. 3 To add a title, click in the title box, and start typing. Do the same for the subtitle box. 
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Create Slides 
The next step is to start creating slides. This step can initially feel overwhelming, but 
we will work on it together. To begin, identify the number of your presentation’s main 
points. For now, plan on one slide per main point. The total number of slides will be 
equal to the number of main points plus one (the title slide). 

To add a new slide, open the Home tab and click on New Slide from the Slides 
group. Repeat to achieve the desired number of slides (Figure 2.4). 

 
Figure 2. 4 The New Slide tool is in the Slides group of the Home tab, which is located in the top left corner of the window. 

Clicking the down arrow beside New Slide opens a variety of slide layout options, 
allowing you to choose what works best for your content (Figure 4.5). Layout options 
include a totally blank slide, ones that combine title and content, and others that 
include placeholders for charts and/or images. Slide layouts can be edited at any 
time. Choose the layout that best fits your content and presentation for now, but 
don’t worry too much because you can always adjust and make changes as you see 
fit. This is the magic of PowerPoint! 
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Figure 2.5 Layout options under New Slide include “Title Slide,” “Title and Content,” “Section Header,” “Comparison,” and 
more, ranging from blank to options for including pictures and captions. 

After you’ve added the number of slides needed for your content, the next step is to 
add information on each slide by clicking into the text boxes and typing. Although 
this may seem daunting, remember that you can edit as needed. Putting text on the 
slides gives you an idea of how the presentation is taking shape (Figure 2.6). Normal 
View, which shows thumbnails of slides in the left pane and the active slide in the 
right pane, gives you a general idea of the presentation and allows you to easily 
identify areas that need improvement. 
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Figure 2.6 Normal view allows you to see your presentation at a glance and identify areas needing improvement. 
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Modifying Presentations in PowerPoint 
Objectives of Chapter Three 

1. Arranging & Formatting Text 
2. Aligning Objects 

Arranging & Formatting Text 
Organizing For Readability 

The way you present text in a presentation matters. An appropriate arrangement will 
have a beneficial visual impact. Sometimes, the standard way to present information is 
not the best way to capture the attention of your audience.  

The space between lines in a paragraph makes the difference between being easier or 
harder to read. It is recommended to always create your presentation in a way that is 
easy to read. In the Paragraph Group, the user can identify an option that helps with 
this performance. The user can set up default settings or customize them as needed. 

The maximum number of ideas in a slide is five. Avoid saturation and ensure the slides 
are not overloaded with content. If a topic has more than five ideas, consider adding 
additional slides.  

Bullets and numbers are a good way to arrange information on a slide. The difference 
between bullets and numbers is in the information itself. If the ideas need to follow a 
specific order, then numbers are the best option. Bullets are the best option if the 
information does not need to follow a particular order.  

Paragraph Group Tools 
To format your text, the most useful tools are in the Paragraph Group of the Home 
ribbon. Left to right, these are Bullets, Numbering, Decrease List Level, Increase List 
Level, Align Left, Center, Align Right, Justify, and Add or Remove Columns. 
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Bullets: This tool (Figure 3.1 point a) allows you to arrange content (ideas, points of 
view, vocabulary terms, etc.) in a list that doesn’t necessarily have a specific order 
(Figure 3.1 point b).  

 
Figure 3.1.The Bullets tool (point a) arranges content that doesn’t necessarily have a specific order (point b) 

Numbering: This tool (Figure 3.2 point a) creates a numbered list of items that 
require a specific order (Figure 3.2 point b). 
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Figure 3.2.The Numbering tool (point a), found in the Paragraph group of the Home ribbon, allows users to create 
numbered lists (point b) 

Increase List level: This tool (Figure 3.3 point a) is used to create or modify an item 
in a multi-level list. Depending on the established style, it may move the list item to 
the right and/or make it smaller (Figure 3.3 point b). 

Decrease List Level: This tool (Figure 3.4 point a) is used to exit or decrease a level 
in a multi-level list. Depending on the established style, it may move the list item to 
the left and/or make it larger (Figure 3.3 point b). 
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Figure 3.3 With the cursor on the lowest item in the list, clicking “Increase List Level” (point a) moved the bulleted text to 
the right and reduced the font size (point b). 
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Figure 3.4. With the cursor on the lowest item in the list, clicking “Decrease List Level” (point a) moved the bulleted text 
back to the left and increased the font size (point b). 

 

Align left: This tool (Figure 3.5 point a) is used to align selected text to the left side 
of a text box (Figure 3.5 point “b”). This is PowerPoint’s default setting.  

Center: This tool (Figure 3.6 point a) is used to align selected text to the center of 
the text box (Figure 3.6 point b). 
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Figure 3.5. Align Left (point a), in the Paragraph group of the Home ribbon, aligns the content to the left side of the textbox 
(point b). 
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Figure 3.6 Align Center (point a), in the Paragraph group of the Home ribbon, aligns content to the center of the textbox 
(point b). 

Align Right: This tool (Figure 3.7 point a) is used to align selected text with the right 
edge of the text box (Figure 3.7 point b). 

Justify: This tool (Figure 3.8 point a) is used to make selected text align to both the 
left and right edges of the textbox. This alignment is achieved through spacing 
between words (Figure 3.8 point b). 
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Figure 3.7 Align Right  (point a), in the Paragraph group of the Home ribbon, aligns content to the right edge  of the textbox 
(point b). 
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Figure 3.8. Justify (point a), in the Paragraph group of the Home ribbon, aligns content to the both the left and right edges  
of the textbox (point b). 

Line and paragraph spacing: This tool (Figure 3.9 point a) allows users to control 
the space lines and paragraphs. It opens a menu that allows the user to choose 
single spacing (1.0), one and a half spacing (1.5), double spacing (2), etc. Clicking 
on “Line spacing options” or the down arrow beside the button opens the Paragraph 
window (Figure 3.9 point b). 

 
Figure 3.9 Line and Paragraph spacing (point a), in the Paragraph group of the Home ribbon, is used to control the space 
between lines. Clicking the down arrow beside the button opens the Paragraph window (point b). 

Text Options 

Presentation Considerations 
It is essential to identify a text style that connects with your topic and audience. A 
presentation’s font can influence how it is perceived. For example, if you are presenting the 
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topic of cartoon cars to a group of kindergarten students, you might use the casual Comic 
Sans MS font, or something similar. You would avoid Times New Roman since this type of 
font is too formal for the setting.  

The size of font used in a slide is important since you need the text to be legible. Although 
some may think larger fonts a requirement, larger fonts take up more space within the 
slide, reducing the space for pictures, figures, graphs, etc. It is important to create an 
adequate balance between font size and space needs. 

 

Changing the color of the text can be more appealing to the eye. At the same time, the user 
needs to consider the contrast between the text and the background. This is a vital 
consideration since audience members may be colorblind. 

Font Group 
The Font group on the Home ribbon is used for changing the font, size, and features 
of the text in a presentation, including attributes such as bold, italic, underline, text 
highlight color, and font color. It also includes a button to clear formatting. These 
tools can be selected prior to entering new text or to change specific text that the 
user has highlighted. 

Font: The font pulldown menu allows users to select from installed fonts. Users can 
begin typing a font name to search for it (Figure 3.10 point a) or choose a font from 
the list (point b). As the user scrolls through the list, the selected text or textbox 
shows a preview of the selected front (point c). 

Font Size: This function changes the size of the font (Figure 3.11 point a). Users can 
enter a number or select one from the pull-down menu (Figure 3.11 point b). 
Scrolling through the numbers will generate a preview  of the selected size (Figure 
3.11 point  c). 

Bold: This tool (Figure 3.12 point a) makes characters more visible by bolding them 
(point b).  
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Italic: This tool (Figure 3.13 point a) changes the appearance of the characters and 
makes them tilt a little to the right (Figure 3.13 point b). Italicized text is used to add 
emphasis or indicate titles.  

Underline: This tool (Figure 3.14 point a) creates a line under selected characters 
(point b). 

Text Highlight Color: This tool (Figure 3.15 point a) “highlights” selected text, giving 
it a colorful background (point b). 

Font Color: This tool (Figure 3.16 point a) sets text color. The user can select from 
standard colors or customize their own (point b).  

Clear All Formatting: This tool resets any formatting customization and returns the 
text to its default style (Figure 3.17). 

 
Figure 3.10 The Font tool (point a), in the Font group of Home ribbon, allows users to select or change the font (point b), 
which is previewed on the slide (point c). 
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Figure 3.11 The Size tool (point a), in the Font group of the Home ribbon, allows users to select or change the font size 
(point b), which is previewe on the slide (point c). 

 

 

 
Figure 3.12 The Bold tool (point a), in the Font group of the Home ribbon, allows users to emphasize text by making it 
darker and bolder (point b). 
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Figure 3.13 The Italic tool (point a), in the Font group of the Home ribbon, allows users to emphasize text by making it slant 
to the right (point b). 

 

 
Figure 3.14 The Underline tool (point a), in the Font group of the Home ribbon, allows users to emphasize text by 
generating a line under it (point b). 
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Figure 3.15 The Text Highlight Color tool (point a), in the Font group of the Home ribbon, allows users to emphasize text by 
giving it a highlight in one of  several different color options (point b). 

 

 
Figure 3.16 The Font Color tool (point a), in the Font group of the Home ribbon, allows users to select a font color from an 
established pallete or to create their own (point b). 
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Figure 3.17 The Clear All Formatting tool (point a), in the Font group of the Home ribbon, resets any text attributes to the 
default format (b). 

 

  

Aligning Objects 
When the user is trying to figure out the best way to place the information, images, 
and/or graphs in a slide, the slide often loses the alignment between objects. That is 
why an alignment tool can be beneficial in setting up a presentation. 

The Align Objects tool, on the Shape Format ribbon, allows users to align objects 
on the same slide, including textboxes. With two or more objects selected, users 
can choose to align left, center, and right, as well as top, middle, and bottom (Figure 
3.18). 
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Figure 3.18 The Align Objects tool, on the Shape Format ribbon, allows users to align 
objects like textboxes. 
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Enhance a Presentation 
Objectives of Chapter Four 

1. Themes 
2. Images 
3. Grouping 

Themes 
The content of a presentation must be engaging. This begins with powerful words for 
effective audience impact. After you decide on the correct content to include in your 
presentation, it is time to unlock your creativity and capture the audience's attention 
visually. A theme is about more than colors; it’s about creating or identifying the correct 
style for your message. Let’s create presentation styles together. 

1. Go to the Design ribbon (Figure 4.1) 
2. The Themes group offers a  large number of design options, which can all be 

viewed by clicking the down arrow at the right side of the preview frame 
(Figure 4.2) 

3. Once the user selects a theme style (Figure 4.3), it is applied to the 
presentation 
Users can adjust elements of the chosen theme, including colors, fonts, and 
effects, by adjusting the options available by clicking the down arrow in the 
Variants group (Figure 4.4) 

 

 
Figure 4.1 The Design ribbon is to the right of File, Home, Insert, and Draw at the top of the window. 
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Figure 4.2 The Themes group has more options than those that are displayed. The user can click the arrow to see more. 

 

 
Figure 4.3 Themes offer established designs to structure a presentation. 
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Figure 4.4 Variance group presents diverse ways to change the same slide style.  
 

Imaging 
Providing a visual reference can influence the audience by assisting them in visualizing the 
idea being shared. Because of this, images are essential in the visual appearance of a 
presentation. Compare the slides shown in Figures 4.5 and 5.5. The slide in Figure 4.5, 
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which contains only text, may look incomplete. On the other hand, Figure 4.6 helps to 
complete the idea just with an image. 

 
Figure 4.5 Slides with text only, and no images, may be unclear 

 
Figure 4.6 Adding a simple graphic to the slide emphasized and strengthens the text title. 
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Adding an Image 
1. Go to the Insert ribbon (Figure 4.7) 
2. In the Images Group, click on Pictures (Figure 4.8) 
3. Select the file location and open it 
4. After inserting the image, drag to position it on the slide 

 

 
Figure 4. 7 The Insert ribbon is to the right of the Home ribbon, at the top of the window. 

  

 
Figure 4. 8 Pictures is one of the options in the Images Group on the Insert ribbon. 
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Notes 
 

i The ideas for this introduction were arranged with the help of artificial intelligence. 

ii The following information was elaborated using POPAI software. 
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